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Brick'n'Tiles User Documentation

1  What is Bricks'n'Tiles?

With Bricks'n'Tiles you can create perfectly seamless brick textures in photorealistic quality 
in a couple of minutes. Just select a few bricks from any source images such as photos 
taken with a digital  camera.  Bricks'n'Tiles  automatically  arranges  the bricks  and slightly 
alters the brick colors by random to create any possible brick pattern. 

The Idea behind  Brick'n'Tiles  is  to  create  seamless  tiling  texture  files  of  architectural  surfaces. 
Usually when creating brick textures like stone walls, floor tiles or roof tiles you have a photo of a 
real surface to start with. Then you can make the texture seamless if you wish to repeat the texture 
on large surfaces.  This can be achieved by correcting the perspective distortion caused by the 
cameras point of view and editing the borders of the image to create seamless borders. 



Texture projected on the 3d model:
There  are  no  visible  seams  at  the 
joining texture borders.

Texture repeated in X and Y direction:
There  are  no  visible  seams  between 
each tile of the texture.

1.1  How to create a perfectly seamless Brick Texture?
Most of the common Paint Software like Adobe PhotoShop, Corel PhotoPaint or Jasc PaintShop 
Pro have sophisticated tools to handle both, the perspective correction and some kind of a “Create 
Seamless Texture”  Filter.  But especially when working with brick textures any visible seam can 
destroy the illusion of a realistic scenery.  Because every brick has its own color and texture any 
irregularity of the brick pattern can cause you hours of working on blending the borders of the image 
with the paint brush and the clone brush tools. Finally you have to partially adjust the brightness and 
the contrast because bright and dark areas (e.g. slight shadows or natural stain and dirt) can cause 
artificially looking unnatural patterns when repeating the texture.

1.2  Isn't there any easier way?
Bricks'n'Tiles creates perfectly seamless tileable textures of any brick surface. Bricks'n'Tiles has 
implemented several algorithms to achieve regular and irregular brick patterns. All you have to do is 
to cut out a few single bricks in your source image, save each brick to an image file and load them 
in Bricks'n'Tiles. You can increase the diversification by using options to randomly change Hue, 
Saturation or Luminance of each brick, applying irregular brick borders, or randomly flip the bricks 
horizontally or vertically. This will help you saving a lot of time.

1.3  More Architectural Texturing Features
Brick'n'Tiles  also helps  you with  other  problems  dealing  with  brick  textures.  While  texturing  3d 
Models  and  especially  architectural  objects  you  need  to  have properly  aligned  textures  at  the 
object's corners. Because technically there is the same brick on both walls next to the a corner – 
and they have to be from a similar color and structure to create realistic buildings. Bricks'n'Tiles also 
supports special texture types for Arches and Columns which you now can create from one single 
picture of any wall.



1.4  What does it cost?
Bricks'n'Tiles is free but it is Feedbackware what means that you are asked to give feedback to the 
author of the software when you have used the software for some time. Also, you are free to send 
any questions or give suggestions that could help to improve the functions of the software in further 
versions. 

If you are using Bricks'n'Tiles in commercial projects you have to buy the Commercial Version. For 
details see: www.3d-rekonstruktionen.de/bricksntiles

2  Installation and Support

2.1  Installation
Please  download  and  install  the  Setup-Program.  You  can  download  the  Program  at 
www.bricksntiles.com

The Setup-Program will create a new folder in your programs folder and install the Program. The 
folder will also contain some example files and this user manual.

Note: In order to use this program on your PC you need Microsoft Windows.

2.2  Support
Support for Bricks'n'Tiles is available at the following destinations:

Bricks'n'Tiles Homepage: www.bricksntiles.com

Bricks'n'Tiles Forum: www.bricksntiles.com/community/
Bricks'n'Tiles FAQs: www.bricksntiles.com/community/viewforum.php?f=2

Bricks'n'Tiles Tutorials: www.bricksntiles.com/tutorials/
Bricks'n'Tiles Galleries: www.bricksntiles.com/community/viewforum.php?f=6

http://www.bricksntiles.com/community/
http://www.bricksntiles.com/tutorials/
http://www.bricksntiles.com/community/viewforum.php?f=6
http://www.3d-rekonstruktionen.de/BricksNTiles/forum/viewforum.php?f=2
http://www.bricksntiles.com/
http://www.bricksntiles.com/
http://www.3d-rekonstruktionen.de/bricksntiles


3  Creating Brick Textures

3.1  Find suitable Source Images

3.1.1  Bricks
Basically you can use any photographic  material  as source images.  Because we won't  use the 
whole image it don't have to be from superior quality. We only need some bricks, which are visible 
in the image and not occluded by other objects. If you don't find enough different brick to create a 
whole wall you can also use more than one source image.

The first thing to do is to analyze the brick bound and you have to answer a few questions:

• Is there any regularity recognizable in the brick pattern? 

• Are the brick widths and heights somehow symmetrically? 

• With proportions have the brick heights and widths?

Bricks'n'Tiles provides you different brick algorithms to recreate a certain brick pattern. Actually the 
algorithms defines how each brick row is shifted towards the adjacent brick rows. In combination 
with variable row heights and brick widths Bricks'n'Tiles can represent the most brick types.

The Row Offsets Types:

Random Row Offset 50% Row Offset No Row Offset

• Random Row Offset: Each brick row 
will be shifted horizontally by a random 
offset. This means the bricks won't be 
aligned  to  each  other  in  vertical 
direction. If you use different values for 
the Min and Max Brick Widths you can 
create  completely  irregular  brick 
patterns.

• 50% Row Offset:  Each brick row will have a row offset of alternately 0% and 50% of the 
current brick width. That means the bricks will be aligned to each other in vertical direction. 
Use this option to create more regular patterns. If you use different values for the Min and 
Max Brick Widths Brick'n'Tiles will use the Min and Max value alternately, e.g. to represent a 
wall made of clay bricks. 

• None: No offset will be used. If you use the same values for the Min and Max Brick Width 
you will get a checker board like pattern.



Row Offsets Types in combination with 
different values for Min and Max Brick Size:

Random Row Offset 50% Row Offset No Row Offset

Now you can extract the bricks from your Source Image. Open your Image Editing Software and 
load the Source Image. If you need to adjust colors, contrast, brightness or  the perspective than do 
so. Now you can select each brick with the Select tool, copy it to the Clipboard (Ctrl-C) and paste it 
to a new image (Ctrl-V), then save it (e.g. as “brick.001.bmp”). The brick files should have at least 
the same width and height which it will have in the final texture file. It is also a good starting point to 
have images that shows the brick face with as less as possible perspective distortion. Thus the best 
source material are photos taken directly in front of the original brick surface. It it is not possible to 
obtain a perfectly orthogonal  photo you can use the tools to change perspective and to correct 
perspective distortion in your Paint Program.

3.1.2  Mortar
The second component you may need to create brick textures is the grout. You can specify the size 
of the gaps between the bricks if there should be any visible seams. You can define the color of this 
material by selecting a Mortar file. This image can basically be any photo of a plaster or cement 
surface. It should have at least the same resolution as the final texture. 

If you found a image which nearly represents the structure of the mortar in your source images, you 
may have to adjust the contrast or the color balance of the image in order to fit to the brick images.  
You can do this in your Paint Program or in Brick'n'Tiles by using the Mortar File Button in the 
Options Panel, selecting the Mortar File and clicking the Edit Button.

3.2  Adjusting the Brick Parameters
After defining the Brick Pattern parameters in the General Option Panel you need to define the size 
that each brick should have. Use the Brick Width and Brick Height parameters in the Brick Size 
Option Panel.  This  defines  how many bricks will  be arranged in horizontal  (Width)  and vertical 
(Height) direction. Because these parameters describe the brick size by percentage of the overall 
texture size you have to use lower values to have more bricks in a row and higher values to have 
less bricks.

All other parameters such as the distance between the bricks, the size of the rounded border, the 
noise strength are refer to the Brick Width and Height values. 

If you need bricks with different size you have different options. Use the Brick Pattern parameters to 
define if the brick size will  be calculated by random if there are two alternating small  and large 
bricks. You can use the Min and Max values to define the minimal or maximal width calculated by 
random or respectively the size of small and the large brick. 

If  you  want  to  achieve  more  variations  of  bricks,  you  could  use  the  “Allow  Horizontal  Flip” 
(recommended)  or “Allow Vertical Flip” (not recommended) in the Brick Files Option Panel, and in 
addition to change the color of the bricks by changing the hue, the saturation and/or the luminance 
parameters in the same Option Panel. These values define the maximal random variation for each 
brick, values around 5% are recommended, higher values could cause a too strong effect.



3.3  Texturing a 3d Model
If you want to use a brick texture on a 3d models, you need to save the image as an image file such 
as a BMP or JPG file. If you use special textures like Brick Border or Arches Textures you need to 
save the images to a file format which supports alpha channels, e.g. The PNG file format.

In the 3d program create a new material and assign it to the 3d object. In the Diffuse channel of the 
material – in some 3d applications also known as the Color channel – load the Seamless Brick 
Texture and create a UV mapping for the model as described in you 3d application's online help. 

If you use special texture types like Brick Border Textures, use different UV mapping channels and 
different Material IDs for each texture map (seamless brick texture, left border, right border or arch 
textures...). Blend these textures by using the image's alpha channel provided by Bricks'n'Tiles in 
the Transparency (aka Opacity) channel of your material.

There will be a special tutorial which covers the procedure of texturing 3d models with Brick'n'Tiles 
brick textures. Visit www.bricksntiles.com for new tutorials.

http://www.bricksntiles.com/


4  The User Interface

4.1  The Main Menu

4.1.1  File Menu

New

Creates a new Brick File and sets all parameters to default values.



Open

Opens a File Dialog in which you can select a Brick File by choosing the an existing Brick File.

Save

Saves the current Brick File. If the file has not been saved yet you will be ask to specify the location 
and the name of the file in a File Dialog.

Save As

Saves the Brick File to an different file. You can specify the location and the name of the file in a 
File Dialog. To save a Image File use Export Image.

Export Image

Exports  the  texture  image  to  an  image  file.  The  following  image  formats  are  supported  by 
Bricks'n'Tiles:

• *.bmp 

• *.png (supports transparency)

• *.jpg 

• *.gif 

• *.tif 

Exit 

Closes the Application Window.

4.1.2  Edit Menu

Edit Image

Opens a Window where you can edit the image that is currently visible in the Preview Window. In 
the Edit Window you can change the size and some other parameters of the image. In addition 
there are various image filters to adjust the color, contrast, saturation etc. A detailed description of 
the Edit Window you can find here.

You can also use this  feature  to  create  a normal  map texture  from a heigh  map created  with 
Brick'n'Tiles. See here if you want to know how the Normal Map Filter works.

Copy to Clipboard

Copys the image that is currently displayed in the Preview Window to the Clipboard. 



4.1.3  View Menu

Center Image

Aligns the Preview Image to the center of the Preview Window. You can also press F9 to center the 
image. Use the Center Image Command in the View Menu if the image is moved or zoomed out of 
range of the Preview Window. 

Optimal View

Shows the Preview Image at the optimal Zoom Extend. The image will be displayed at the center of 
the Preview Window and with no Zoom if the whole image fits to the current window size. Otherwise 
the zoom extend will be set to fit the window.

Show Tiles

Enables and disables the Show Tiles Mode. If the Show Tiles Mode is on, the image in the Preview 
Window will  be repeated in every direction. This helps you to examine if the texture's border is 
perfectly seamless. If it is not seamless you will notice a hard edge between adjoining tiles instead 
of a smooth transition. You can also use Ctrl-T to  toggle Show Tiles Mode on and off.

4.1.4  Zoom Menu



Fit to Window

Zooms the Preview Image to the current size of the Preview Window.

No Zoom

Set the Zoom Extend to 100%. This shows the image in the Preview Window at its original size.

Zoom

The Zoom Menu provides you some default Zoom values from 10% to 500%.

Zoom Out

Reduces the Zoom Extend of the image in the Preview Window by 10%. 

Zoom In

Increases the Zoom Extend of the image in the Preview Window by 10%. 

4.1.5  Options Menu

Background Color

In the Background Color Menu you can change the color of the Preview Window. This could be 
useful to indicate the Alpha Channel of a semi-transparent image. You can choose between the 
default colors or choose a color in the Windows Color Picker Dialog.



4.1.6  Help Menu

View Help

This provides you the Help Files with the complete reference and some tutorials to Brick'n'Tiles.

Show Info

Shows a Dialog Box with provides some information about Brick'n'Tiles, e.g. the Version Number 
and the Software License agreement.

Note: In Version 1.5 there are some additional Menu Items in the Help Menu which will open you 
web browser to display the Bricks'n'Tiles support pages.

4.2  The Tool Bar

The Tool Bar provides some icons with often used commands such as:

• New Brick File   (Ctrl-N)

• Open Brick File   (Ctrl-O)

• Save Brick File   (Ctrl-S)

• Update Image  

• Copy Preview Image to Clipboard   (Ctrl-C)

• Show Tiles   (Ctrl-T)

• Center Image in Preview Window   (F9)

• Fit image to Preview Window   (F5)

• Zoom Out   (F7)

• Zoom In   (F8)

If you move the mouse over the buttons a small Tool Info will appear showing a brief description 
and the Short Cut if available.

4.3  The Preview Window

4.3.1  Navigation

Pan

To move the image in the Preview Window simply click the left mouse button and move the mouse 
while keeping the left  mouse button pressed.  To finish to operation just  release the left  mouse 
button or press the right mouse button instead to cancel the operation.



Zoom

To zoom in or out the image press the right mouse button and move the mouse left or right while 
keeping the right mouse button pressed. To finish to operation just release the left mouse button or 
press the right mouse button instead to cancel the operation.

Show Tiles

Show Tiles is a useful  tool while working with seamless textures. To see how it is working see here.

Center Image

Use the Center Image Command in the View Menu if the image is moved or zoomed out of range of 
the Preview Window.

Optimal View

To view the image centered and in the optimal size use the Optimal View Command in the View-
Menu.

4.3.2  Image Operations

Copy Image to Clipboard

You can Copy the image in the Preview Window to the Windows Clipboard by clicking the Copy To 
Clipboard Command in the Edit Menu or by pressing Ctrl-C.

Export Image to File

To save the image in the Preview Window to a file on disk click the Export Image Command in the 
File Menu or by pressing Ctrl-X.

Edit Image

If you want to edit the image (e.g. Change the color, the contrast or the saturation of the image) use 
the Edit Image Command in the Edit Menu.

4.4  The Display Panel
In this window you can define the size and the type of the generated image. 

4.4.1  Final Image
Let you define the size of the output image. It depends on the available memory if the generated file 
is correctly rendered. If you recognize any problems, try to free some memory or to reduce the 
image resolution.

If Maintain Aspect Ration is checked the image size is restricted to quadratic shape (which means 
the same width & height) as required for some 3d Applications or Game Engines.

4.4.2  Preview
If you switch to the Preview Panel you can define a small and faster generated output size without 
changing the actual image size. In addition this panel has a Dropdown Menu where you can choose 
the Quality of the Preview image. This setting may save render time but won't affect the final output 
image.



4.4.3  Seamless Texture
Creates  a  seamless  tileable  brick  texture  which  you  can  use  the  texture  wall,  roof  and  floor 
surfaces.

4.4.4  Left Border
Creates a texture which you can blend over the seamless brick texture at the left border to achieve 
a continuous brick pattern around your 3d model. 

Note: The resulting image will have an alpha channel which contains the transparency for blending 
it with the background. You should save the file in an image format which supports alpha channels 
(e.g. PNG) in order to use the transparency in your 2d or 3d application for texture blending.

4.4.5  Right Border
Creates a texture which you can blend over the seamless brick texture at the right border to achieve 
a continuous brick pattern around your 3d model.

Note: The resulting image will have an alpha channel which contains the transparency for blending 
it with the background. You should save the file in an image format which supports alpha channels 
(e.g. PNG) in order to use the transparency in your 2d or 3d application for texture blending.

4.4.6  Both Borders
Creates both the left and the right border in one image. This may be useful if you paint your textures 
in a Picture Editing Software such as Adobe PhotoShop, Jasc PaintShop Pro or Corel PhotoPaint.

Note: The resulting image will have an alpha channel which contains the transparency for blending 
it with the background. You should save the file in an image format which supports alpha channels 
(e.g. PNG) in order to use the transparency in your 2d or 3d application for texture blending.

4.4.7  Arch Texture
Creates one or more brick rows which you can use to texture window and door arches or vaults. 
Simply apply the curvature as a new UV channel to your 3d model and blend the Arch Texture over 
the existing brick textures. It will smoothly blend into the existing textures due to its adjustable alpha 
channel.

Note: The resulting image will have an alpha channel which contains the transparency for blending 
it with the background. You should save the file in an image format which supports alpha channels 
(e.g. PNG) in order to use the transparency in your 2d or 3d application for texture blending.

4.4.8  Column Texture
Creates a texture for columns made of only one brick per row. This means that one brick will be 
visible  from  all  directions  and  have  to  tile  seamlessly.  The  Column  Texture  will  be  perfectly 
seamless so you won't see any texture artifacts in your final scene.

4.4.9  Update / Cancel Button
Starts the generation of the image. You can stop the operation by pressing the Button again, when it 
is labeled as “Cancel”. 

4.5  The Options Panel
In the Options Panel  you can define all  relevant  parameters for  the texture generation like the 
desired brick pattern, size and also the image files which you want to use. 



4.5.1  General 

Name

Enter a Name for the brick texture.

Description

Enter a short description for the brick file (optional).

Row Offset

Choose then type of the Brock Pattern from the Drop Down Menu:

• Random: Each brick row will have a random offset. That means that the bricks in different 
rows will not be aligned to each other.

• 50%: Each brick row will have an alternating row offset. Each brick will be aligned to the 
center of the corresponding bricks in the adjacent brick rows.

• None: No offset is used. Use this setting to create checker board like brick patterns, e.g. for 
floor tiles.

Random ID

Use this number to initialize the Random Generator with. The same Random ID will reproduce the 
same brick  pattern.  You  only  need  to  change this  value  in  order  to  create  different  new brick 
distribution. To change the value by random use the button at the right side.

Note: If you don't want to change the brick pattern but to redistribute the brick files in the current 
pattern use the Rearrange Brick Files Option.

Rearrange Brick Files

If checked the Rearrange Brick Files Option causes a redistribution of the brick files on each update 
without changing the actual brick pattern. Use this option when creating different texture files than 
will be used in layers. 

• Off: If the bricks in two layers should correspond to each other then set this option to off.  
This is useful when creating a Bump Map that should correspond to a Color Map, so one 
brick will always have the same Bump Map.

• On: If the bricks in two layers should be different from each other then set this option to on.  
This is useful when creating a Dirt Maps for a corresponding Color Map with non-repeating 
Dirt-Color combinations.



4.5.2  Brick Size

Min Width

Specifies then minimal width of a brick. 

Note: The width of each brick is calculated by random between Min Width and Max Width. In 50% 
Row Offset Mode Min Width and Max Width are used alternately.

Max Width

Specifies then maximal width of a brick. 

Note: The width of each brick is calculated by random between Min Width and Max Width. In 50% 
Row Offset Mode Min Width and Max Width are used alternately.

Min Height

Specifies then minimal height of a brick. 

Note: The height of each brick is calculated by random between Min Height and Max Height. 

Max Height

Specifies then maximal height of a brick. 

Note: The height of each brick is calculated by random between Min Height and Max Height. 

4.5.3  Brick Shape

Distance

Defines then size of the brick border which is the gap between adjoining bricks. If you don't need 
grout between the bricks set the Distance Value to 0.



Rounded

Most  bricks  are  not  perfectly  rectangular,  they  rather  have  slightly  rounded  edges.  This  Value 
defines the radius of the rounded edge.

Smoothness

Defines the size of the area in which the brick texture will be blended into the mortar texture. Small 
values causes hard changes, large values causes smooth transitions.

Strength

You can change the brick shape from rectangular  to uneven or irregular  shapes.  The Strength 
Value defines the size of this irregularity.

Frequency

The Frequency of the irregular brick shapes changes the style of this irregularity smooth, wavy to 
fuzzy, noisy shapes.

4.5.4  Brick Files

Select Brick Files Button

Click on this button to select or change the brick files. Each brick file should contain a texture of one 
single brick face.

Allow Horizontal Flip

Defines if the brick can be flipped horizontally to create more brick variations. 

Allow Vertical Flip

Defines if the brick can be flipped vertically to create more brick variations. 

Note: This option may produce strange results because usually the upper side of a brick is more 
weathered than the lower side. Therefore the resulting image could look unnatural if some bricks 
are flipped vertically.

Change Hue

Define the maximal random hue change of each brick file in order to achieve more brick variations. 
Set this Value to 0 if you don't want any color adjustments to your brick files.



Change Saturation

Defines the maximal random saturation change of each brick file in order to achieve more brick 
variations. Set this Value to 0 if you don't want any color adjustments to your brick files.

Change Luminance

Defines the maximal random luminance/brightness change of each brick file in order to achieve 
more brick variations. Set this Value to 0 if you don't want any color adjustments to your brick files.

4.5.5  Mortar File

Select Mortar File Button

Click this button to select or edit a file with a mortar texture which is visible between the bricks (if 
brick border distance is greater  than 0).  For brick walls  or floor  tiles you can basically use any 
plaster or cement textures. They don't need to be tileable because you can apply seamless borders 
in Bricks'n'Tiles.

Repeat X

Defines how often the Mortar texture should be repeated in horizontal direction.

Repeat Y

Defines how often the Mortar texture should be repeated in vertical direction.

Blend Border Area

Defines the size of the blended borders which make the Mortar Texture seamless. Set this value to 
0 if the image already is a seamless texture.

Horizontally Seamless

Check this option if the Mortar Texture should be made horizontally seamless.

Vertically Seamless

Check this option if the Mortar Texture should be made vertically seamless.



4.6  The Texture Options Dialog

4.6.1  Border Texture Options

Border Textures are made for texturing buildings or other rectangular shaped objects where 
adjoining edges need to have continuous textures.  You can find more information about 
Border Textures here.

Blend Size

Adjusts the extend of the alpha blend at the texture borders. 

Brick Offset

Default Offset type is the setting defined in the  Row Offset Drop Down Menu. You can choose a 
different type for the Borders.

4.6.2  Arch Texture Options

An  Arch  Texture  is  a  special  texture  type  which  helps  you  texturing  arched  doorways, 
arched windows or vaults. You can find more information about Arch Textures here.



Width

Defines the length of the Arch Texture in pixels. Note that the Brick Min Width and Max Width are 
not affected by this value. This value defines how many bricks are displayed per row.

Height

Defines the height of the Arch Texture in pixels. Note that the Brick Min Height and Max Height are 
not affected by this value. This value defines how many bricks rows are displayed.

Brick Offset

Default Offset type is the setting defined in the  Row Offset Drop Down Menu. You can choose a 
different type for the Arch Texture.

4.6.3  Column Texture Options

A Column Texture is a brick texture which is horizontally and vertically tileable so you can 
use them to texture objects like columns, pillars or stairs. You can find more informations 
about Column Textures here.

Width

Defines the length of the Arch Texture in pixels. Note that the Brick Min Width and Max Width are 
not affected by this value. This value defines how many bricks are displayed per row.

Height

Defines the height of the Arch Texture in pixels. Note that the Brick Min Height and Max Height are 
not affected by this value. This value defines how many bricks rows are displayed.

Blend Size

Defines the size of the blended borders when making the texture seamless. If you use brick textures 
that already are tileable, you should set this value to 0.

4.7  The Brick Files Dialog



4.7.1  File List
Contains all selected Brick Files. If you click on one of the files, you will see a preview on the right 
side of the list.

4.7.2  Remove
Removes the selected file from the list.

4.7.3  Remove All
Removes all files from the list.

4.7.4  Edit
Opens a Window where you can edit the selected image. In the Edit Window you can change the 
size and some other parameters of the image. In addition there are various image filters to adjust 
the color, contrast, saturation etc. A detailed description of the Edit Window you can find here.

4.7.5  Add Files
Select one ore more images to be used as brick textures. If you want to select more than one file in 
one  folder, hold the Ctrl key pressed while selecting the files.



If you want to see a preview of the files just select Thumbnails from the Explorer View Drop Down 
Menu as shown in following the picture: 

4.8  The Mortar Files Dialog



4.8.1  Select File Button
Press this button to select the file you want to be used as the Mortar texture. For brick walls or floor 
tiles you can basically use any plaster or cement textures. They don't need to be tileable because 
you can apply seamless borders in Bricks'n'Tiles. 

If you want to know more about the Open Image File Dialog e.g. how to preview the image files, see 
here.

4.8.2  Remove
Removes the selected file from the list.

4.8.3  Edit
Opens a Window where you can edit the selected image. In the Edit Window you can change the 
size and some other parameters of the image. In addition there are various image filters to adjust 
the color, contrast, saturation etc. A detailed description of the Edit Window you can find here.

4.9  The Texture Preview Window

4.9.1  Navigation

Pan

To move the image in the Preview Window simply click the left mouse button and move the mouse 
while keeping the left  mouse button pressed.  To finish to operation just  release the left  mouse 
button or press the right mouse button instead to cancel the operation.

Zoom

To zoom in or out the image press the right mouse button and move the mouse left or right while 
keeping the right mouse button pressed. To finish to operation just release the left mouse button or 
press the right mouse button instead to cancel the operation.



Show Tiles

Enables and disables the Show Tiles Mode. If the Show Tiles Mode is on, the image in the Preview 
Window will  be repeated in every direction. This helps you to examine if the texture's border is 
perfectly seamless. If it is not seamless you will notice a hard edge between adjoining tiles instead 
of a smooth transition. You can also use Ctrl-T to  toggle Show Tiles Mode on and off.

Center Image

Aligns the Preview Image to the center of the Preview Window. You can also press F9 to center the 
image. Use the Center  Image Command if  the image is moved or zoomed out of range of the 
Preview Window. 

4.9.2  The Main Menu

The File Menu

Open

Opens an image file.

Save As

Saves the current image.

Close

Closes the Preview Window

The Edit Menu

Copy to Clipboard

Copies the current image to the Windows Clipboard.

Paste from Clipboard

Paste a new image from the Windows Clipboard.



Delete

Deletes the current image without saving the changes

.

The View Menu

Center

Aligns the Preview Image to the center of the Preview Window. You can also press F9 to center the 
image.

Fit to Window

Zooms the Preview Image to the current size of the Preview Window.

No Zoom

Set the Zoom Extend to 100%. This shows the image in the Preview Window at its original size.

Zoom

The Zoom Menu provides you some default Zoom values from 10% to 500%.

Zoom Out

Reduces the Zoom Extend of the image in the Preview Window by 10%. 

Zoom In

Increases the Zoom Extend of the image in the Preview Window by 10%. 

Background Color

In the Background Color Menu you can change the color of the Preview Window. This could be 
useful to indicate the Alpha Channel of a semi-transparent image. You can choose between the 
default colors or choose a color in the Windows Color Picker Dialog.



Interpolation Mode

Provides different interpolation filters for the preview display.

Show Tiles

Enables and disables the Show Tiles Mode. If the Show Tiles Mode is on, the image in the Preview 
Window will  be repeated in every direction. This helps you to examine if the texture's border is 
perfectly seamless. If it is not seamless you will notice a hard edge between adjoining tiles instead 
of a smooth transition. You can also use Ctrl-T to  toggle Show Tiles Mode on and off.

The Image Menu

Rotate

Rotates the current image by 90° in different directions.

Flip Horizontally

Mirrors the current image horizontally.

Flip Vertically

Mirrors the current image vertically.

Resize Image

Let you resize the current image to a higher or a lower resolution. 



The Color Menu

Adjust Brightness / Contrast

Adjusts the Contrast and the Brightness of the image. Enter values from -255 to 255 to add or 
remove Contrast and Brightness. If you enter 0 as values it won't have any effect to your image.

Adjust Red / Green / Blue



Adjusts the Color Balance of the image. Enter values from -255 to 255 to increase or decrease the 
strength of the three color channels. The different values for Red, Green and Blue will tint the image 
as shown in the following table:

Color Channel / Value -255 ... -1 0 1 ... 255

Red Cyan No effect Red

Green Magenta No effect Green

Blue Yellow No effect Blue

Adjust Hue /  Saturation / Luminance

Adjusts the Hue, Saturation and Luminance of the image. Enter values from -180 to 180 to change 
the Hue of the image. The values are in degrees and represent a certain color in the Color Circle as 
shown in the next table:

blueblue magentamagenta redred yellowyellow greengreen cyancyan blueblue

-180-180 -120-120 -60-60 00 6060 120120 180180

Enter values from -100 to 100 to change the overall Color Saturation and Luminance of the image.

Adjust Gamma / Threshold

Corrects the Gamma and the Threshold Values of the image. Enter Value from 0 to 10 for Gamma 
and Values from 0 to 255 for Threshold.

The Effects Menu



Grayscale Image

Converts the current image to gray scale image.

Sepia Toning

Applies a Sepia (“Old Photo”) Effect.

Histogram Equalize

Equalizes the current image's histogram.

Show Contours

Applies a Contour Effect. This effect detects all the edges in the image. The output image may look 
like a drawing or a cartoon if there are enough edges to trace. This effect could be very interesting 
for trouble shooting a Seamless Texture or a Brick Map because it amplifies the natural structure of 
the bricks.

Show Alpha Channel

Converts the current image's alpha channel to a gray scale image. The image's color informations 
will be lost so make sure you have saved the image before.

The Image Filters Menu

Sharpen

Sharpens the image. 



Noise

Adds some Noise to the current image. This may be useful to simulate natural structures.

The Texture Filters Menu

Create Seamless Texture

Makes the current image's borders seamless. This may be useful if you want to use the image as a 
tileable texture. The Blend Borders Value specifies the Strength of the effect. Note that too high 
values may wash out the structure of the image while too small values won't cause the visible edges 
to disappear.

Create Transparent Borders



Adds transparent  borders  around the current  image.  You can choose between rectangular  and 
noisy shapes even with rounded borders. Please note that you have to use an image file format that 
supports transparency (such as PNG) in order to preserve the transparency of the borders.

Convert Height Map to Normal Map (New in version 1.5.3)

This function allows you to create a Normal Map from a Height Map. The Height Map should be a 
grayscale bitmap which represents the height of a surface. The option “Save Height Map to Alpha 
Channel” let you store both maps into a single texture. Please note that you have to use an image 
file format that supports transparency (such as PNG) in order to preserve the height map in the 
alpha channel.

Use this function to create a normal map of an bump map texture created with Bricks'n'Tiles. First, 
you have to define two or more grayscale images for the brick and for the mortar images where the 
mortar image is darker than the brick image to give the bricks some height. Then create the final 
brick texture, choose Edit Image in the Edit Menu  to open the Preview Window and select the 
Normal Map Filter. Then you can save your normal map to a file.

Height Map Normal Map


